TITLE: DG-10.4: CODE TEST REVIEW REPORT GUIDELINE VERSION 3.0

AUTHORS:
Ken Jensen (Raytheon Information Solutions)

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Revised Sections</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>No version 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.0</td>
<td>Renamed Code Test Review Report Guideline, DG-10.4, and revised by Ken Jensen (Raytheon Information Solutions) for version 3.</td>
<td>All</td>
<td>10/1/2009</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>LIST OF ACRONYMS</td>
<td>6</td>
</tr>
<tr>
<td>1.</td>
<td>INTRODUCTION</td>
<td>7</td>
</tr>
<tr>
<td>1.1.</td>
<td>Objective</td>
<td>7</td>
</tr>
<tr>
<td>1.2.</td>
<td>The Test Readiness Review Report</td>
<td>7</td>
</tr>
<tr>
<td>1.3.</td>
<td>Background</td>
<td>8</td>
</tr>
<tr>
<td>1.4.</td>
<td>Benefits</td>
<td>8</td>
</tr>
<tr>
<td>1.5.</td>
<td>Overview</td>
<td>8</td>
</tr>
<tr>
<td>2.</td>
<td>REFERENCE DOCUMENTS</td>
<td>9</td>
</tr>
<tr>
<td>3.</td>
<td>STANDARD TABLE OF CONTENTS</td>
<td>10</td>
</tr>
<tr>
<td>4.</td>
<td>SECTION GUIDELINES</td>
<td>11</td>
</tr>
<tr>
<td>4.1.</td>
<td>Table of Contents</td>
<td>11</td>
</tr>
<tr>
<td>4.2.</td>
<td>List of Figures</td>
<td>11</td>
</tr>
<tr>
<td>4.3.</td>
<td>List of Tables</td>
<td>11</td>
</tr>
<tr>
<td>4.4.</td>
<td>List of Acronyms</td>
<td>12</td>
</tr>
<tr>
<td>4.5.</td>
<td>Section 1 – CTR Entry Criteria</td>
<td>12</td>
</tr>
<tr>
<td>4.6.</td>
<td>Section 2 – CTR Risks</td>
<td>14</td>
</tr>
<tr>
<td>4.7.</td>
<td>Section 3 – CTR Actions</td>
<td>15</td>
</tr>
<tr>
<td>4.8.</td>
<td>Section 4 – CTR Exit Criteria</td>
<td>18</td>
</tr>
<tr>
<td>4.9.</td>
<td>Section 5 – SRR Entry Criteria</td>
<td>20</td>
</tr>
<tr>
<td>4.10.</td>
<td>Section 6 – SRR Exit Criteria</td>
<td>20</td>
</tr>
<tr>
<td>4.11.</td>
<td>Section 7 – Summary</td>
<td>20</td>
</tr>
<tr>
<td>4.12.</td>
<td>Section 8 – List of References</td>
<td>20</td>
</tr>
</tbody>
</table>
5. CTRR UPDATES ......................................................................................... 21

APPENDIX A – CTR CHECK LIST ..................................................................... 22

APPENDIX B - TEMPLATES ........................................................................... 23
   B.1 Cover Page Template: ................................................................. 24
   B.2 Document Header Template: ......................................................... 25
   B.3 Document Cover Page Footer Template: ...................................... 25
   B.4 Document Footer Template: .......................................................... 25
   B.5 Approval Page Template: .............................................................. 26
   B.6 Version History Page Template: .................................................... 27
   B.7 Figure Caption Template: .............................................................. 28
   B.8 Table Title Template: ................................................................. 28
   B.9 List of References Template: ......................................................... 29
LIST OF FIGURES

Figure 2.3 - <Figure caption in Arial regular 12 point font> ................................................ 28

LIST OF TABLES

Table 4.5 - <Table title in Arial regular 12 point font> ......................................................... 28
## LIST OF ACRONYMS

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDR</td>
<td>Critical Design Review</td>
</tr>
<tr>
<td>CDRR</td>
<td>Critical Design Review Report</td>
</tr>
<tr>
<td>CICS</td>
<td>Cooperative Institute for Climate Studies</td>
</tr>
<tr>
<td>CIMSS</td>
<td>Cooperative Institute for Meteorological Satellite Studies</td>
</tr>
<tr>
<td>CIOSS</td>
<td>Cooperative Institute for Oceanographic Satellite Studies</td>
</tr>
<tr>
<td>CIRA</td>
<td>Cooperative Institute for Research in the Atmosphere</td>
</tr>
<tr>
<td>CL</td>
<td>Check List</td>
</tr>
<tr>
<td>CLI</td>
<td>Check List Item</td>
</tr>
<tr>
<td>CMMI</td>
<td>Capability Maturity Model Integration</td>
</tr>
<tr>
<td>CREST</td>
<td>Cooperative Remote Sensing and Technology Center</td>
</tr>
<tr>
<td>CTD</td>
<td>Code Test Document</td>
</tr>
<tr>
<td>CTR</td>
<td>Code Test Review</td>
</tr>
<tr>
<td>CTRRR</td>
<td>Code Test Review Report</td>
</tr>
<tr>
<td>DG</td>
<td>Document Guideline</td>
</tr>
<tr>
<td>EPL</td>
<td>Enterprise Product Lifecycle</td>
</tr>
<tr>
<td>N/A</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>NESDIS</td>
<td>National Environmental Satellite, Data, and Information Service</td>
</tr>
<tr>
<td>NOAA</td>
<td>National Oceanic and Atmospheric Administration</td>
</tr>
<tr>
<td>PAR</td>
<td>Process Asset Repository</td>
</tr>
<tr>
<td>PG</td>
<td>Process Guideline</td>
</tr>
<tr>
<td>PRG</td>
<td>Peer Review Guideline</td>
</tr>
<tr>
<td>SG</td>
<td>Stakeholder Guideline</td>
</tr>
<tr>
<td>SRR</td>
<td>System Readiness Review</td>
</tr>
<tr>
<td>STAR</td>
<td>Center for Satellite Applications and Research</td>
</tr>
<tr>
<td>TD</td>
<td>Training Document</td>
</tr>
<tr>
<td>TG</td>
<td>Task Guideline</td>
</tr>
<tr>
<td>TRR</td>
<td>Test Readiness Review</td>
</tr>
<tr>
<td>TRRR</td>
<td>Test Readiness Review Report</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

The NOAA/NESDIS Center for Satellite Applications and Research (STAR) develops a diverse spectrum of complex, often interrelated, environmental algorithms and software systems. These systems are developed through extensive research programs, and transitioned from research to operations when a sufficient level of maturity and end-user acceptance is achieved. Progress is often iterative, with subsequent deliveries providing additional robustness and functionality. Development and deployment is distributed, involving STAR, the Cooperative Institutes (CICS, CIMSS, CIOSS, CIRA, CREST) distributed throughout the US, multiple support contractors, and NESDIS Operations.

NESDIS/STAR is implementing an increased level of process maturity to support the exchange of these software systems from one location or platform to another. The Code Test Review Report (CTRR) is one component of this process.

1.1. Objective

The objective of this Document Guideline (DG) is to provide STAR standards for the CTRR. The intended users of this DG are the Code Test Review (CTR) reviewers who are responsible for writing the CTRR.

1.2. The Test Readiness Review Report

A CTRR is produced following a project’s CTR. It is a required project artifact of the STAR Enterprise Product Lifecycle (EPL).

A separate CTRR is produced for each distinct product in the STAR Enterprise during the Development phase of the STAR EPL.

The intended target audiences are program management, the product development team, and the System Readiness Review (SRR) reviewers.

The CTRR should be developed as a Microsoft Word document. Upon approval, the approved version of the CTRR may be converted to an Adobe pdf file for storage in the project artifact repository.

---

1 Refer to the STAR EPL Process Guidelines (PG-1 and PG-1.A) for a description of the STAR EPL gates and reviews.

2 For a description of the STAR EPL, refer to the STAR EPL Process Guidelines (PG-1 and PG-1.A)
The CTRR Appendix should be a Microsoft Excel document. Upon approval, the approved version of the CTRR Appendix may be converted to an Adobe pdf file for storage in the project artifact repository.

1.3. Background

This DG defines guidelines for producing a CTRR. This DG has been adapted from Capability Maturity Model Integration (CMMI) guidelines. It has been tailored to fit the STAR EPL process.

1.4. Benefits

A CTRR developed in accordance with the standards in this DG assists the development team to create a technical solution that meets customer needs and user expectations. It is therefore a requirement that a CTRR be written in accordance with the guidelines in this document.

1.5. Overview

This DG contains the following sections:

- Section 1.0 - Introduction
- Section 2.0 - References
- Section 3.0 - Standard Table of Contents
- Section 4.0 - Section Guidelines
- Section 5.0 - CTRR Updates
- Appendix A - CTR Check List
- Appendix B - Templates
2. REFERENCE DOCUMENTS

All of the following references are STAR EPL process assets that are accessible in a STAR EPL Process Asset Repository (PAR) on the STAR web site:

http://www.star.nesdis.noaa.gov/star/EPL_index.php

PG-1: STAR EPL Process Guideline provides the definitive description of the standard set of processes of the STAR EPL.

PG-1.A: STAR EPL Process Guideline Appendix, an appendix to PG-1, is a Microsoft Excel file that contains the STAR EPL process matrix (Stakeholder/Process Step matrix), listings of the process assets and standard artifacts, descriptions of process gates and reviews, and descriptions of stakeholder roles and functions.

PRG-10: Code Test Review Peer Review Guideline is the PRG for preparing, conducting and closing a CTR. The PRG describes the standard CTR artifacts and the relevant STAR EPL process assets. It also states the standard CTR objectives, entry criteria, and exit criteria.

PRG-11.1: System Readiness Review Peer Review Guideline is the PRG for preparing, conducting and closing an SRR. The PRG describes the standard SRR artifacts and the relevant STAR EPL process assets. It also states the standard SRR objectives, entry criteria, and exit criteria.


TG-10: STAR EPL Code Test and Refinement Task Guidelines provides a description of standard tasks for process step 10, during which the CTRR is written.

DG-0.1: STAR Document Style Guideline is a STAR EPL Document Guideline (DG) that provides STAR standards for the style and appearance of STAR documents developed as Microsoft Word files.
3. STANDARD TABLE OF CONTENTS

LIST OF FIGURES
LIST OF TABLES
LIST OF ACRONYMS

1.0 CTR ENTRY CRITERIA

2.0 CTR RISKS

3.0 CTR ACTIONS
   3.1 Completed Actions
   3.2 Open Actions
   3.3 New Actions

4.0 CTR EXIT CRITERIA

5.0 SRR ENTRY CRITERIA

6.0 SRR EXIT CRITERIA

7.0 SUMMARY

8.0 LIST OF REFERENCES

APPENDIX A – CTR CHECK LIST DISPOSITION
4. SECTION GUIDELINES

This section contains the STAR guidelines for each section of the CTRR.

The CTRR should follow the STAR standard for style and appearance, as stated in DG-0.1.

4.1. Table of Contents

The Table of Contents can be inserted by using Word’s Insert ➔ Reference ➔ Index and Tables ➔ Table of Contents function or by pasting the Table of Contents from this DG into your document and updating it for the section headers you make for your document. Use a page break if necessary to ensure that the Table of Contents appears at the top of a page.

4.2. List of Figures

A List of Figures should be provided after the Table of Contents. A page break should be used if necessary to ensure that the List of Figures appears at the top of a page. To create a List of Figures, use Word’s Insert ➔ Reference ➔ Index and Tables ➔ Table of Figures function, selecting the “Table of Figures” Style. Alternatively, the List of Figures can be created by pasting the List of Figures for this DG into your document.

Figures should be created by using Word’s Insert ➔ Picture ➔ From File function or Word’s Insert ➔ Object function. Figures should be numbered X.Y, where X is the main section number where the figure resides and Y = 1,N is the ordered number of the figure in the section. Figure captions should have Arial bold 12 point font, should be center justified, and should have a “Table of Figures” Style. A Figure Caption template is provided in Appendix B of this DG.

4.3. List of Tables

A List of Tables should be provided after the List of Figures. The List of Tables can appear on the same page as the List of Figures, with three blank lines separating them, provided both lists can fit on the same page. If both lists cannot fit on the same page, a page break should be used to ensure that the List of Tables appears at the top of a page.
To create a List of Tables, use Word’s Insert ➔ Reference ➔ Index and Tables ➔ Table of Figures function, selecting the “Table - Header” Style. Alternatively, the List of Tables can be created by pasting the List of Tables for this DG into your document.

Tables should be created with the Table ➔ Insert ➔ Table function. Tables should be numbered X.Y, where X is the main section number where the table resides and Y = 1,N is the ordered number of the table in the section. Table titles should have Arial bold 12 point font, should be center justified, and should have a “Table - Header” Style. A Table Title template is provided in Appendix B of this DG. Table text should have Arial regular 10 point font.

### 4.4. List of Acronyms

The use of acronyms is encouraged. A two word or longer name for an item (e.g., Code Test Review Report) should be given an acronym (e.g., CTRR) if the name is used more than once in the document. A List of Acronyms should be provided after the List of Tables. The List of Acronyms should be in alphanumeric order. Use the List of Acronyms in this DG as a template. A page break should be used if necessary to ensure that the List of Acronyms appears at the top of a page.

### 4.5. Section 1 – CTR Entry Criteria

Explain the disposition of each CTR entry criteria item. The CTR entry criteria are established in the Test Readiness Review Report (TRRR). Report the entry criteria as bulleted items. For each item, report the following:

- A statement of the entry criteria item
- The disposition of the item. Possible dispositions include:
  - Pass – The item is approved.
  - Conditional Pass – The item is approved conditionally. Explain the condition or conditions. The condition or conditions typically involve one or more specific actions that must be closed to pass the item. Refer to the Section 3 subsection of the CTRR where these actions are stated.
  - Defer – The item is deferred for consideration at a later review (e.g. SRR), often with recommended actions to be addressed prior to that review. Refer to the Section 3 subsection of the CTRR where these actions are stated. Explain
the reason for deferral and state the recommended review at which the item
should be considered. There should be a clear and convincing rationale for
deferring any entry criteria item to a review other than a delta CTR. The most
common rationale will be schedule and resource constraints, combined with a
demonstration that actions associated with the deferral can be taken in
parallel with planned post-CTR tasks.

- Waive – The item has been excused for this project’s lifecycle. Explain the
  reason for waiving the item.

- Not Applicable (N/A) – The item is not applicable to this project’s lifecycle.
The distinction between this disposition and the “Waive” disposition is that
“Waive” items are applicable to the project’s lifecycle, though they have been
excused for some reason. This disposition will only occur if the item was
mistakenly included in the project’s CTR Check List. Explain why this item
should not be in the project’s CTR Check List.

- A list of open actions pertaining to the item, including new actions.

- Any additional comments that are deemed relevant by the reviewer.

The following format for this section is recommended:

------------------------------------------------------------------------------------------------------------------------
- Entry # 1 - <Entry criteria # 1 Statement>
  o STATUS: <Disposition (e.g. PASS), use upper case>
  o COMMENTS: <Any pertinent comments (e.g. rationale for the disposition, a
    list of associated actions) plus a reference to sections of the SRRR where the
    risk and associated actions are discussed>
------------------------------------------------------------------------------------------------------------------------

- Repeat for each entry criteria item
4.6. Section 2 – CTR Risks

The status of each project risk should be presented in the Code Test Document (CTD). The TRD is described in PRG-10 and TG-10. The CTR reviewers should update this status, based on their judgment following the CTR. Refer to PG-1 for standard risk assessment techniques.

Provide an overview of the risk history and risk status. Itemize and report on the identified risks. Each risk should be reported as follows:

- **Risk Statement** – the risk number and statement. It is recommended that risks be numbered in chronological order as to when they are identified.
- **Risk History** – For a risk that was identified prior to the CTR, note the date and/or the review when it was identified and its original evaluation status (e.g. High, Medium, Low). For a risk that originates with this report, note that it is a new risk.
- **Assessment** – the results from analysis of the risk. The assessment should include qualitative evaluation (e.g. High, Medium, Low) and quantitative evaluation (Severity and Probability). PG-1 provides guidelines for these assessments.
- **Mitigation** – recommended steps to mitigate the risk
- **Pertinent Actions** – List the action designation for each open action that pertains to the risk. The action designation convention is “XXX i,j,k,l”, where “XXX” is the acronym for the review where the action was generated (e.g. CDR), “i,j,k” is the number of the review Check List Item (CLI) that generated the action, and “l” is the unique action number. For example, the third action generated by the CTR CLI 1.7.23 would be designated “CTR 1.7.23.3”.

An example follows:

- **RISK # 2 - The project requirements do not take into account all customer needs and expectations**
  - Risk History: New risk
  - Risk Assessment: HIGH (Severity = 8, Probability = 7, Score = 56)
4.7. Section 3 – CTR Actions

The status of risk mitigation actions for each project risk should be presented in the CTD. The CTD is described in PRG-10 and TG-10. The CTR reviewers should update this status, based on their judgment following the CTR.

Itemize and report on the recommended actions. There should be subsections for Completed Actions, Open Actions, and New Actions.

The subsection for Completed Actions should itemize and report on all previously identified actions that have been completed or withdrawn. Each action identified prior to CTR should be included in the CTD. Actions should be numbered. Adopt the action number used in the CTD. Each completed action should be reported in alphanumeric order, as follows:

- An action number, followed by an action statement.
- A statement of the criteria for closing the action.
A statement of the status of the action. The status will be “Closed” or “Withdrawn”. There should be a demonstration that the closure criteria have been satisfied or a rationale for withdrawing the action.

For example:

ACTION: CDR 1.1.1.1 - Discuss project objectives with customers and users to ensure that they are derived from customer needs and expectations.

- Closure Criteria
  - Confirmation that the project objectives are in line with customer needs and expectations

- Closure Plan
  - Discuss the project objectives with customers
  - Document customer agreement with the project objectives in the Code Test Document (CTD)

- Status:
  - **Closed**. The CTD documents customer agreements with the project objectives.

Completed actions may be listed in numerical order, but it is more useful to group them according to the risk that generates them, following the standard presentation of risks and actions in the CTD.

The subsection for Open Actions should report the status of each action from previous reviews that the CTR reviewers determine has not been completed. Typically, these actions have been presented at the CTR as still open, with a recommended closure plan. In that case, the CTR reviewers may accept the closure plan or recommend a modified plan. Each action identified prior to CTR should be included in the CTD. Adopt the action number used in the CTD. Each open action should be reported in alphanumeric order, as follows:

- An action number, followed by an action statement.
A statement of the criteria for closing the action.

A statement of the closure plan for the action. A proper closure plan description should include a list of tasks, assignment of tasks, needed resources, task schedule, impact on the project plan, criteria for approval and risks. A closure plan for each action should be provided by the development team prior to the CTR if possible.

A statement of the status of the action. The status will be “Open”.

There may be cases where the CTR reviewers determine that an action presented as completed is still open because the closure criteria have not been completely met. In that case, the action status should be stated as “Open”, with recommended steps for closure.

For example:

---

**ACTION: CDR 1.1.1.1 - Discuss project objectives with customers and users to ensure that they are derived from customer needs and expectations.**

- **Closure Criteria**
  - Confirmation that the project objectives are in line with customer needs and expectations

- **Closure Plan**
  - Discuss the project objectives with customers
  - Document customer agreement with the project objectives in the Code Test Document (CTD)

- **Status:**
  - **Open.** The CTD documents customer agreements with the project objectives and treats this action as completed, but the CTR Reviewers have determined that the CTD does not document the agreement of customer X. Recommended steps for closure are listed in new action CTR n1.n2.n3.n4.

---
Open actions may be listed in numerical order, but it is more useful to group them according to the risk that generates them, following the standard presentation of risks and actions in the CTD.

The subsection for New Actions should itemize and report on all actions that have been identified at the CTR. New actions may originate from the development team and be presented in the CTD. Alternatively, they will be identified by the CTR reviewers and documented for the first time in the CTRR. Actions identified at the CTR should be numbered as “CTR n1.n2.n3.n4”. “n1.n2.n3” should correspond to the CTR check list item responsible for generating the action. “n4” is a unique number (1, 2, 3, etc.).

- A statement of the criteria for closing the action.
- A statement of the closure plan for the action. A proper closure plan description should include a list of tasks, assignment of tasks, needed resources, task schedule, impact on the project plan, criteria for approval and risks. For each action identified by the development team at the CTR, a closure plan should be included in the CTD. The CTR reviewers should adopt this closure plan or modify it if warranted. For each action identified by the CTR reviewers, the reviewers should provide a recommended closure plan.
- A statement of the status of the action. The status will be “Closed” or “Open”. For each action listed as “Closed”, there should be a demonstration that the closure criteria have been satisfied.

New actions may be listed in numerical order, but it is more useful to group them according to the risk that generates them, following the standard presentation of risks and actions in the CTD.

4.8. Section 4 – CTR Exit Criteria

Explain the disposition of each CTR exit criteria item. The CTR exit criteria are established in the TRRR. Use a separate subsection for each item. Each subsection should include the following:

- A statement of the exit criteria item
- The disposition of the item. Possible dispositions include:
  - Pass – The item is approved.
Conditional Pass – The item is approved conditionally. Explain the condition or conditions. The condition or conditions typically involve one or more specific actions that must be closed to pass the item. Refer to the Section 3 subsection of the CTRR where these actions are stated.

Defer – The item is deferred for consideration at a later review (e.g. SRR), often with recommended actions to be addressed prior to that review. Refer to the Section 3 subsection of the CTRR where these actions are stated. Explain the reason for deferral and state the recommended review at which the item should be considered. There should be a clear and convincing rationale for deferring any exit criteria item to a review other than a delta CTR. The most common rationale will be schedule and resource constraints, combined with a demonstration that actions associated with the deferral can be taken in parallel with planned post-CTR tasks.

Waive – The item has been excused for this project’s lifecycle. Explain the reason for waiving the item.

Not Applicable (N/A) – The item is not applicable to this project’s lifecycle. The distinction between this disposition and the “Waive” disposition is that “Waive” items are applicable to the project’s lifecycle, though they have been excused for some reason. This disposition will only occur if the item was mistakenly included in the project’s CTR Check List. Explain why this item should not be in the project’s CTR Check List.

- A list of open actions pertaining to the item, including new actions.
- Any additional comments that are deemed relevant by the reviewer.

The following format for this section is recommended:

```
- Exit # 1 - <Exit criteria # 1 Statement>
  o STATUS: <Disposition (e.g. PASS), use upper case>
  o COMMENTS: <Any pertinent comments (e.g. rationale for the disposition, a list of associated actions) plus a reference to sections of the CTRR where the risk and associated actions are discussed>
```
• Repeat for each exit criteria item

4.9. Section 5 – SRR Entry Criteria

State the entry criteria for the next technical review, the SRR. The STAR EPL standard SRR entry criteria can be found in STAR EPL process asset PRG-11.1. Project-unique SRR entry criteria should be found in the project’s Development Project Plan (DPP). Additional tailoring may be necessary to accommodate deferred items in the CTR Check List. The CTR Reviewers should determine this and revise the SRR entry criteria as needed.

4.10. Section 6 – SRR Exit Criteria

State the exit criteria for the next technical review, the SRR. The STAR EPL standard SRR exit criteria can be found in STAR EPL process asset PRG-11.1. Project-unique SRR exit criteria should be found in the project’s DPP. Additional tailoring may be necessary to accommodate deferred items in the CTR Check List. The CTR Reviewers should determine this and revise the SRR exit criteria as needed.

4.11. Section 7 – Summary

A Summary section is provided for the CTR reviewers to include any concluding remarks that are deemed useful to the SRR reviewers. The section can also add recommendations to the development team that are not already captured by the recommended actions.

4.12. Section 8 – List of References

This section should consist of a List of References that includes all references cited in the document. Include all references deemed useful by the CTR reviewers. References should be listed in alphabetical order. References that begin with an author list should begin with the last name of the lead author. A template is provided in Appendix B.
5. CTRR UPDATES

The CTRR should be updated to record the closing of “Conditional Pass” items after the CTR. CTRR updates should include a change history. This should be captured in the Version History section (c.f. Appendix B.6 of this DG) and also explicitly noted in the appropriate subsections of the main document. There should be at least one CTRR update prior to a delta CTR. If there are no “Conditional Pass” items, there is no need for a CTRR update and no need for a delta CTR. Even so, a CTRR update may be made at the discretion of the CTR Review Lead if it is deemed useful to update risk evaluations or other comments for the benefit of the SRR reviewers.
APPENDIX A – CTR CHECK LIST

A completed CTR Check List should be included as an Appendix to the CTRR. The appendix should be in the form of a Microsoft Excel spreadsheet and an Object in the Microsoft Word document that should be created by pasting the spreadsheet into the document.

The CTR reviewers can use the standard Check List provided in the CTR Check List spreadsheet (STAR EPL process asset CL-10) to record their disposition of the CLIs, if the Check List for this project’s CTR has not been modified. If there is a tailored Check List, the CTR reviewers should use a modified spreadsheet that includes the tailored CTR Check List items that have been agreed to. The CTR Check List items that have been approved for a specific project should be included in the DPP (Appendix C).

The Review Lead is responsible for the correctness of the check list. The Review Lead can, and usually should, delegate responsibility for various items on the check list to various review team members.

An example of a filled-in CTR Check List will be placed in the STAR EPL PAR.
APPENDIX B - TEMPLATES

This appendix contains templates for specific pages and sections of the CTRR.
B.1 Cover Page Template:

In this template, <X> = 1.0 for version 1, <X> = 1.1 for version 1 revision 1, <X> = 2.0 for version 2 etc. <Project Name> should be the actual approved name of the Project.

NOAA NESDIS CENTER for SATELLITE APPLICATIONS and RESEARCH

<PROJECT NAME>
CODE TEST REVIEW REPORT
Version <X>
B.2 Document Header Template:
In this template, <X> = 1.0 for version 1, <X> = 1.1 for version 1 revision 1, <X> = 2.0 for version 2 etc.

In this template, <Project Name> should be the actual approved name of the Project.

In this template, <Y> = the actual page number.

In this template, <Z> = the actual total number of pages

---

B.3 Document Cover Page Footer Template:

---

B.4 Document Footer Template:
B.5 Approval Page Template:

In this template, <X> = 1.0 for version 1, <X> = 1.1 for version 1 revision 1, <X> = 2.0 for version 2 etc. <Project Name> should be the actual approved name of the Project.

TITLE: <PROJECT NAME> CODE TEST REVIEW REPORT VERSION <X>

AUTHORS:

<Lead Author>
<Co-Author 1>
<Co-Author 2>
<etc.>

APPROVAL SIGNATURES:

_________________________________________<Actual Signature Date>
<Name of CTR Review Lead> Date
CTR Review Lead

_________________________________________<Actual Signature Date>
<Name of Project Manager> Date
Project Manager

_________________________________________<Actual Signature Date>
<Name of Agency Approver> Date
Agency
**B.6 Version History Page Template:**

In this template, *<Project Name>* should be the actual approved name of the Project.

```
<PROJECT NAME>
CODE TEST REVIEW REPORT
VERSION HISTORY SUMMARY

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Revised Sections</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Created by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt;.</td>
<td>New Document</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>1.1</td>
<td>[As needed] Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; to include updated status of CTR actions</td>
<td>&lt;applicable sections&gt;</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>etc.</td>
<td>Ditto</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```
B.7 Figure Caption Template:

**Figure 2.3** - <Figure caption in Arial regular 12 point font>

B.8 Table Title Template:

**Table 4.5** - <Table title in Arial regular 12 point font>
B.9 List of References Template:


END OF DOCUMENT